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No Help Available
No help is available for this area of the window.



No Help Available
No help is available for this message box.



View Menu Commands
The View menu offers the following commands:

Bag Displays the contents of the bag.
Score Displays the current score.
Rankings Displays the ranking table.
Toolbar Shows or hides the toolbar.
Bag Counter Shows or hides the bag counter.
Status Bar Shows or hides the status bar.

Bag Command (View menu)
Use this command to display the contents of the bag.    In Tantrix the bag starts with 56 tiles and 
gets smaller as each tile is played.    The bag cannot be viewed under competition rules or when 
playing a puzzle.



Score Command (View menu)
Use this command to display the current score.



Rankings Command (View menu)
Use this command to display the Rankings dialog box.



Toolbar Command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in Tantrix, such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Tantrix,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click to

Start a new game.

Open an existing game.    Tantrix displays the Open dialog box, in which you can locate 
and open the file you want.

Save the current game with its current name.    If you have not named the game, Tantrix 
displays the Save As dialog box.

Print the current game.

Copy the current game to the clipboard.

Reverse the last move.

Replay the current game move by move.

Rotate the selected tile or the whole tantrix anti-clockwise.

Rotate the selected tile or the whole tantrix clockwise.

View the help topics.

View context sensitive help.



Status Bar Command (View menu)
Use this command to display and hide the Status Bar, which describes the state of the Tantrix 
game.    A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar
The status bar is displayed at the bottom of the Tantrix window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes the state of the Tantrix game or puzzle.



View Rankings Dialog Box
The current rankings table is displayed.    Rankings are only entered when a game is played 
between just two players under competition rules.    A ranked game must be played online in one 
session (so you cannot play by email or save and re-open the game).

A new player starts with the rank of 300 and moves up or down in the ranking table depending 
on the rank of the other player, and of course whether they won or lost.

Whenever the rank of the person at the top of the ranking table changes they get an opportunity 
to enter some "Words of Wisdom".



Rank Dialog Box
The previous and updated rank of both players is displayed.    A new player starts with a rank of 
300 and moves up or down in the ranking table depending on the rank of the other player, and of 
course whether they won or lost.

Whenever the rank of the person at the top of the ranking table changes they get an opportunity 
to enter some "Words of Wisdom".



Bag Counter Command (View menu)
Use this command to display and hide the Bag Counter, which displays the number of tiles left in
the bag.    A check mark appears next to the menu item when the Bag Counter is displayed.    
Clicking on the Bag Counter toolbar will display the contents of the Bag.



Help Menu Commands
The Help menu offers the following commands, which provide assistance with this application: 

Help Topics Offers you an index to topics on which you can get help.
Help Strategy Offers you help on tantrix game playing strategy.
About Displays the version number of Tantrix.

About Command (Help Menu)
Displays the version number of Tantrix in the About dialog box.



Help About Dialog Box
Displays the version number of Tantrix.



Turn over prompt (email)
Your turn is over.    As you are playing an email game you now need to send the game to the next 
player by email.    You will have to do this manually as either your system does not support the 
CMC/MAPI interface or you are playing a game embedded inside an existing email message (or 
other container).

To send the game to the next player you can use the Edit/Copy menu option and paste the game 
into the body of your email message.    Alternatively, you can use the File/Export command to 
create a text image of the game that can be attached to your email message.



New game error
An error has occurred whilst creating the new game.    This should not normally happen so please
contact technical support.    You should check that each player has a unique colour.



Computer player error
The computer player has made an invalid selection of a tile to be played.    This should not 
happen so please contact technical support.



Computer player error
The computer player has selected a tantrix tile that is invalid.    This should never happen so 
please report this problem to technical support.



System error
An error has prevented the clipboard from being opened.



System error
An error has occurred creating a tantrix game from the text image pasted from the clipboard.    
The text image may have corrupted.    Alternatively, it may be from a previous version of Tantrix.
This means you will not be able to start a new game using the paste option.



Mail error
The recipient of the email is ambiguous or cannot be found.    This means the email address you 
entered when you started a new game is incorrect.    You should save the game and attach the 
resulting file to an email message you can then send manually.



System error
An error has occurred attempting to access the Windows registry.    You should still be able to 
play Tantrix but the settings or new game information you have entered will not be saved.

Please report this problem to technical support.



Mail error
Your email logon password is incorrect.    This means the automatic process of sending the game 
to the next email player has failed.    You should save the game and attach the resulting file to an 
email message you can then send manually.



Game error
The game is over as there are no more valid moves.    This is very rare but can happen at the end 
of a game.



Game error
This action is not allowed as it is not your move.    While another player is taking their turn you 
cannot move tiles or attempt to make any moves yourself.



System error
An error has occurred creating a tantrix game from the text image read from the import text file.  
The text image in the file may have corrupted.    Alternatively, it may be from a previous version 
of Tantrix.    This means you will not be able to start a new game by importing this file.



System error
An error has occurred replaying the last move.    This should never happen unless for some 
reason the move history in the game has become corrupt.

Please report this problem to technical support.



System error
There is not enough memory to copy the game.    Try to free up more memory by closing other 
applications.



Mail error
For an email game you must enter enter the player's email address.    This email address is used 
when the game is sent to the player so they can take their turn.



Game error
You can only double-click on one of your own tiles positioned above an empty playable tile 
space in the tantrix.    You have double-clicked on one of your own tiles but it is not positioned 
above a playable space.



Mail error
It is not possible to access or logon to your email system using CMC (MAPI).    This is probably 
because you do not have an email system configured for application access using the CMC 
interface.

You should copy the game and paste it into the body of an email message.    Alternatively, you 
can save the game and include the file as an attachment to an email message.



Game error
The Tantrix CD cannot be found.    Please place the Tantrix CD in your CD drive and start your 
game again.    To prevent unauthorised copying of Tantrix the software regularly checks the CD 
is accessible.    To continue playing Tantrix you will need to place the CD in the drive.



Mail error
There is a problem with the email attachment file.    This file is created when automatically 
sending the game to the next email player.    There could be a problem with your computer's 
temporary directory or you could be out of disk space.

You should save the game and attach the resulting file to an email message you can then send 
manually.

Please report this to technical support



Game error
You do not have enough memory to display all the rankings.    Try freeing more memory by 
closing other applications.    If this does not work you should call Technical Support for 
assistance in removing entries from your ranking table.



System error
An error has occurred creating or writing to the export file.    The disk may be full.    Try saving 
to a different directory.



Game error
The computer player has failed to select a move when a move is possible.    The computer player 
has been converted to a "local person" which means you can continue the game but the computer
player will no longer select moves.

Please report this problem to technical support.



System error
An error has occurred opening or reading from the import file.    The text image in the import file
may have corrupted.    Alternatively, it may be from a previous version of Tantrix.    This means 
you will not be able to start a new game by importing from this file.



Mail error
An unexplained error has occurred sending email.    You should save the game and attach the 
resulting file to an email message you can then send manually.



Game error
You are not allowed to use the '+' character in a player’s name, email address or country.    This is
due to the way these three pieces of information are combined to make a unique key into the 
ranking table.    You may use any other character.



Edit Menu Commands
The Edit menu offers the following commands:

Undo Reverse the previous move.
Copy Copy the current game to the clipboard.    The game can then be pasted into the 

text note of an email message and sent to the next player.
Paste Paste a new game from the clipboard.    This option is only available if the 

tantrix game is closed.
Replay Replay the current game from the beginning.
Next Player Advance the game state to the next player.
Next Move Advance to the next move in the replay sequence.
Rotate 
Clockwise

Rotate the currently selected tile or the whole tantrix one face clockwise.

Rotate Anti-
clockwise

Rotate the currently selected tile or the whole tantrix one face anti-clockwise.

Player Details Alter the settings for the current players.    This is not available when playing a 
puzzle or under competition rules.    The colours and types of players cannot be 
altered once a game has been started.

Settings Alter the settings for Tantrix.
Chat Chat to other online players (Windows 95/NT only)



Undo Command (Edit menu)
Use this command to reverse the last move, if possible.    The command will be disabled if your 
last move cannot be reversed (as is the case under competition rules).

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Copy Command (Edit menu)
Use this command to copy the current game to the clipboard.    This command is unavailable if a 
game has not been started.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste Command (Edit menu)
Use this command to start a new game based on a copy of the tantrix game on the clipboard.    
This command is unavailable if the clipboard is empty or if a new game has already been started.

Shortcuts

Toolbar:
Keys: CTRL+V



Settings Command (Edit Menu)
Use this command to alter the settings for Tantrix using the Settings dialog box.



Edit Settings Dialog Box
Specify the way you wish Tantrix to be played:

Sounds
Game Start If ticked the sound of tiles being tipped onto a table will be heard 

whenever a new game is started.
Bag Shake If ticked the sound of the bag of tiles being shaken will be heard after 

every move.
Tile Play If ticked the sound of a tile being played will be heard after each move.

Background
Show Bitmap If ticked Tantrix will display the bitmap appearing in the "Filename" 

entry field as a background to the tantrix.    If this is not ticked the 
background will be a solid colour as defined in the Colours section below.

Filename The filename of the bitmap to be displayed as a background.

Animation
Animate Tiles If ticked the tiles will move gradually across the screen when they are 

played.    If not ticked the tiles move quickly.
Animation 
Speed

This value controls how fast the tiles move across the screen when a 
move is animated.    It can be set to any value between 1 (slowest) and 5 
(fastest).    The fastest way to play tantrix is to disable tile animation by 
removing the tick from the Animate Tiles option.

Other
Show Playable 
Space

If ticked the legal moves appear as shaded spaces next to the tantrix tiles. 
This makes selecting a move much easier.    The tiles that may be played 
are shaded dark grey.

Show Next 
Player Prompt

If ticked a "Next Player" button appears at the end of each player's turn.    
This provides an opportunity for the player to undo the last move before 
the next player begins.    Under competition rules this prompt never 
appears.

Colours
Background The colour of the background area if no bitmap is displayed.
Selected Tile The colour of the selected tile.
Valid Tiles The colour of the tiles which may be legally played.
Playable Spaces The colour of the spaces next to the tantrix into which a tile may be 

legally played.
Reset Resets the four colours above as at the time of installation.



Replay Command (Edit menu)
Replay the current game from the beginning.



Rotate Clockwise Command (Edit menu)
Rotate the currently selected tile one face clockwise.    If no tile is currently selected then the 
whole tantrix is rotated.



Rotate Anti-Clockwise Command (Edit menu)
Rotate the currently selected tile one face anti-clockwise.    If no tile is currently selected then the
whole tantrix is rotated.



Player Details Command (Edit Menu)
Alter the name, email and country information for each player.    This option is not available 
when playing a puzzle or under competition rules.    The colours and types of players cannot be 
altered once a game has been started.    When playing an online game you can only alter the 
details of the local player.



Next Player Command (Edit Menu)
Advance the game state to the next player.



Next Move Command (Edit Menu)
Advance to the next move in the replay sequence.
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WELCOME!
Thank you for purchasing Tantrix. Please read this introduction carefully before getting 
started. You're about to enter a spatial world of kaleidoscopic colour. Take your time - 
Tantrix needs to be DISCOVERED. And just like real life thereis a bit of luck involved and 
lots of skill. To become a proficient player, you'll need to master both the strategic and 
spatial aspects of the game.

Your Tantrix set consists of 56 tiles, painted in links of red, green, blue and yellow. Each tile is 
unique, and with all tiles you'll be able to play both the game and the solitaire puzzles.

The Game
Tantrix Strategy is an elegant game of strategy for two to four players. Most games 
take around half an hour to play. Though the rules are simple, be warned this is not a 
simple game of chance! Persevere, and you'll discover clever strategic planning can 
remove most of the luck.

The Puzzles
There are 25 Tantrix Puzzles that range in difficulty from easy to almost impossible, 
including two as yet 'unsolved' puzzles. All puzzles use various subsets of the 56 
tiles, and usually the more tiles a puzzle has, the harder it is to solve. Of the 25 
puzzles, the most popular are the Super 5 puzzles: Junior, Student, Professor, Master 
and Genius. Many people have tried to solve the Genius yet few have succeeded.

The Tiles
Tantrix has developed its own terminology. ANY tile which has a red link, is called A
RED TILE, and ALL tiles without red are called NO-RED TILES. Likewise for all 
the other colours. Each colour group has fourteen tiles.

Some Definitions
A LINE is a path of one colour. It does not have to be straight, and it may cross over 
or under other colours.
A LOOP is a closed line (line that joins itself). It can be any shape, not necessarily 
perfectly circular or symmetrical.

Feedback
We love feedback so please drop us a line or send an email message. Tantrix 
incorporates contributions from all over the world, and any ideas you send may be 
used in subsequent editions.

Good luck.

The Tantrix Development Team
February 1997, Nelson, New Zealand.



TANTRIX GAME RULES
Tantrix differs from conventional games of strategy like Chess, Go and Trax, which have no luck
involved. In these games the outcome between players of different ability is not in doubt. Tantrix 
however combines complex strategy and chance, making it of interest to serious game players, 
yet still fun for the whole family. The best player will usually win... but not necessarily. Of 
course in the long run the luck factor evens out, so serious players record their winning margins, 
not just wins and losses.

To begin, all the tiles are placed in the bag, and the players each choose a different colour (from 
red, blue, green or yellow). The players then pick up a hand of six tiles at random from the bag 
and place them all face-up on the table. The first player plays a tile in the middle, and 
immediately picks up a new tile. Play continues in a clockwise direction. The second player 
places a tile next to the first tile, always making sure the colours match, then picks up a new tile. 
And so on.

• Each player has one free move per turn.
• All tiles must be played next to tiles already played.
• All touching tiles must match colour (figure 1).
• Each player's hand of tiles must be visible to the other players.
• Players must immediately pick up a new tile each time they play a tile.

Figure 1: Matching colours

FORCED SPACES
An empty space surrounded by three tiles is called a Forced Space. Each player must start their 
turn by filling Forced Spaces whenever possible. Figure 2 shows a Forced Space, and a tile that 
could fit the space. Forced spaces become more common as the game progresses and sometimes 
a number of tiles can be played during the same turn. In fact, when one Forced Space is filled, a 
new Forced Space is often created.



Figure 2: Forced Space

IT'S YOUR TURN!

• Start by identifying any Forced Spaces, and check whether you have any tiles that fit.
Now fill every Forced Space that you can, in any order, picking up a replacement tile after 
each play.

• When you can't fill any more Forced Spaces, make your free move.
• After your free move, again fill every Forced Space you can.
• Pick up a replacement tile after every move (free or forced). You must always have six tiles 

in your hand.



TANTRIX GAME RESTRICTIONS
There are three restricted moves not normally allowed (figure 3). However once there are no tiles
left in the bag, these restriction rules are lifted, and can be ignored by the players. Most players 
will need to experience a few games, before the restriction rules become clear.

Figure 3: Three restrictions

The following are not allowed :
1. Making a Forced Space with three links of the same colour (figure 3.1).
2. Surrounding a Forced Space with a fourth tile (figure 3.2).
3. Playing any tile opposite an existing Forced Space. In figure 3.3 thereis already a Forced 

Space at A, so it is illegal to play a tile at B. The Forced Space at A must be filled before 
tiles can be played anywhere along the side with the arrow.



TANTRIX GAME WINNER
The game ends when all the tiles have been played. Players score one point per tile in their 
longest line, or two points per tile in their longest loop. Only a player's highest score counts, 
regardless of whether it is a line or a loop. Even if you have two long lines, or a line and loop, 
you cannot add them together. Only the single highest score wins.



TANTRIX GAME STRATEGY GUIDE
We recommend you do NOT continue reading this until you have played a few games. You will 
then have a basic understanding of Tantrix and this guide will make much more sense. The guide 
offers strategy advice for the two-player version of Tantrix. Similar strategies may also be used 
in three to four player games.    However, in multiplayer games the luck factor is stronger and 
players have a more equal chance of winning.

Glossary: The guide often refers to Tantrix terminology that has not been previously explained 
in the text. Please make full use of the glossary, referring to it whenever a concept or term comes
up that you don't understand.

Diagrams: For the explanatory diagrams we are using black, white and grey to represent the 
actual colours of the links. The two players will always be Black and White. In most examples 
you (the reader) will be considered the Black player, against a White opponent.

Forced Spaces
Connecting Indirectly
Small Loops
Opening Principles
Isolated Lines
Middle Game
Medium Loops
Big Loops
Spotting Tiles that Fit
Blocked Lines
Deadlock
Isolated Links
Lookalike Spaces
Connect Indirect Connections
First Free Turn
Blocking
Final Tiles



FORCED SPACES
The most important concept in the game is the Forced Space rule (figure. 2). Learn to exploit this
rule. You may be able to play more than one tile per turn, or force your opponent to play tiles in 
places that are good for you! If there is more than one Forced Space to be filled think carefully 
about the order in which you play the tiles. Postpone any undesirable Forced Spaces until last.    
You may pick up tiles which allow other options. Consider the situation in figure 4 where Black 
can force tiles B, C and D simply by playing the tile at A. This is an extreme example where in 
one turn, Black's indirect line length is increased from six to thirteen!!!

Figure 4: Black with 13 point line



CONNECTING INDIRECTLY
Always try to connect to your line indirectly! Each directly connected tile increases your line by 
one, while an indirect connection adds at least two to your line length. In figure 5 the black line 
has an INDIRECT length of five, but when tiles are played at A and B the black line will become
DIRECTLY connected. In the beginning indirect connections are certain to be eventually joined 
together. However, this is less likely towards the end of the game, when all the tiles which could 
fit (eg at A and B) may have already been played elsewhere.

Figure 5: Indirect black line



SMALL LOOPS
In the beginning try to force your opponent to make small loops. In figure 6.1 you (black) are 
being forced to make a small loop which will waste three tiles. Against a good player, you would
have no chance of winning the game if you were forced into a small loop early on. The good 
news is it is almost always possible to avoid being force looped if you are careful! Do not start 
with a black corner link, it is normally too easy for your opponent to force the loop (as in figure 
6.1). Likewise be careful starting with a black bend. Make sure White does not have a matching 
black bend as in figure 6.2. Even in figure 6.3 the seemingly safe three tile black line can easily 
be force looped if White plays the tiles at A and B. The resulting black loop will be worth only 
14 points, and White will easily win.

Figure 6.1: Forced loop (3 tile)

Figure 6.2: Forced loop (4 tile)

Figure 6.3: Black forced loop





OPENING PRINCIPLES
• Getting a good start is important. Maximise the number of links you're able to add to your 

line with each turn. Don't settle for adding just two tiles to your line, when it is often 
possible to add three or more!

• Don't let any of your own (black) links become isolated.
• Always avoid any risk of being force looped, and conversely look for ways to force loop 

your opponent.



ISOLATED LINES
Normally try to develop only one long line. It is always very difficult to connect two isolated 
lines together. Conversely, it is definitely worth trying to keep your opponent's lines isolated 
from each other. Figure 7 shows two black lines. If White plays the tile at A, then you (Black) 
will have difficulty joining your two black lines together!

Figure 7: Two isolated black lines



MIDDLE GAME
Tantrix is most complex during the middle game. A slightly different move can change the whole
course of the game. If White is poised to complete a large loop now is the time to stop her! 
However, if there are good opportunities to extend your own line, or close a loop, then maybe it 
is better to ignore your opponent.



MEDIUM LOOPS
A medium size loop of perhaps eighteen points is not usually enough to win the game. However 
you can still hope to win by restricting your opponent to a line of seventeen points or less. As 
there is no need to work on your own colour, you can spend the rest of the game attacking the 
White player, effectively blocking her at every move. The best way to slow White down is to 
create blocked spaces at both ends of her line. Figure 8 shows a good example. Both ends of 
White's line terminate in unfilled Forced Spaces (blocked spaces). If neither player has tiles that 
could fit these Forced Spaces, White can do nothing but wait.

Figure 8: White blocked at both ends



BIG LOOPS
When your indirect line length is ten or more, think about trying to convert your line into a loop. 
In a typical game the winning score is around twenty-three points, so a loop of twelve tiles could 
mean a win. Always be careful, once you have committed yourself to a loop, there is no way 
back! Make your decision based on how well your opponent is doing and how good your own 
chances are of making a long line instead. In practice big loops are usually very difficult to 
complete, but they are guaranteed to distract the other player.



SPOTTING TILES THAT FIT
When you're looking for tiles to fit a Forced Space, it is useful to identify the three colours 
required in a clockwise direction. For example the Forced Space in figure 9 is a 
black/black/white (BBW) fit. If you need a specific tile to fill a Forced Space then it is possible 
to calculate how many such tiles are left in the bag (see Fit Analysis). All Forced Spaces can be 
'fitted' by just five or six tiles depending on the fit type. This can be a difficult skill for new 
players to acquire, but the more games you play the easier it will get (we promise!). Late in the 
game when there are only a few tiles left, it can be crucial to know if any tiles you need are still 
in the bag. 

Figure 9: BBW Fit



BLOCKED LINES
Never underestimate the importance of keeping both ends of your line free. Too often a player 
will see a way to add a few tiles to their line, and not notice they have detoured their line into a 
blocked space. In figure 10 Black has a good line, but White has just played tile A. Now both the 
Black line ends are blocked on the same controlled side, and Black must wait until the Forced 
Space at B is filled.

Figure 10: Black blocked at both ends



DEADLOCK
If some Forced Spaces remain unfilled for a long time, the game can reach a stage of temporary 
deadlock. Whichever lucky player breaks the deadlock will probably have multiple forced moves
to fill and lots of options, so during the deadlock look for ways to play more than one tile per 
turn. This will increase your chance of picking up a tile that will break the deadlock.

Figure 11 is a good example of a deadlocked game. After tile A has been played there are only 
three legal places left around the tantrix where a tile can be added. The arrows in figure 11 show 
the controlled sides that are created by each unfilled Forced Space. In a blocked game with lots 
of controlled sides, scores for both players are likely to be lower than usual.

Figure 11: Blocked game



ISOLATED LINKS
Try to set up isolated links of your opponent's colour. In figure 12 White has a choice of two 
different tiles which fit the Forced Space so White should play tile A rather than B, as it 
introduces an isolated black link which hopefully will stay isolated!

Figure 12: Isolated black link



LOOKALIKE SPACES
Towards the end of the game imagine that you (Black) need one more tile to complete a very 
long line (the Forced Space at A in figure 13). The tile you need is a WBB fit. White should 
create a lookalike WBB Forced Space, so that if White picks up a WBB tile, she will have an 
alternative Forced Space to play this tile.

Figureure 13: WBB fit



CONNECT INDIRECT CONNECTIONS
As the end game approaches (say five to ten tiles left in the bag) the players should ensure any 
remaining indirect connections are now joined up. At this stage of the game there are often many 
Forced Spaces to fill and the last tiles may be used up much more quickly than most players 
would anticipate.



FIRST FREE TURN
Try to be the player who has the first free turn once there are no tiles left in the bag. With the 
restriction rules lifted you will find it easy to either block your opponent or join up any 
remaining indirect connections of your own.



BLOCKING
The restriction rules no longer apply once all tiles have been picked up from the bag. It is now 
easy to block lines. If one end of your line is already blocked then the other end is very 
vulnerable to attack. Figure 14 shows Black's line about to be blocked at A. The new tile will 
create a Forced Space with three lines of the same colour (impossible to fill). So always try to 
arrive at the end game with both ends of your line unblocked.

Figure 14: Blocked black line



FINAL TILES
One player will run out of tiles before the other. The last player with tiles can normally add any 
remaining tiles to his line with impunity, while the other player just watches! So conserve your 
last few tiles and try not to run out of tiles before your opponent. 



COMPETITION TANTRIX
With increasing skill you will learn to vary your style of play to suit the situation and your 
opponent. For example you might choose to play conservatively, taking few risks and thus being 
sure of at least an average score. Alternatively, you might choose an aggressive approach, 
playing all out for a long line or a large loop win. The perfect strategy will not be the same each 
game! Against a better player bold risky strategies may be your best chance to win. If you are 
playing in a tournament or against a regular opponent, then be more concerned about the size of 
your winning margin (over all games) than your win/loss record. It is the combined winning 
margin over a large number of games which really determines who is the better Tantrix player. It 
is often the case that two regular players seem to share wins and losses about equally, but taking 
into account their winning margins from each game, one player is clearly superior.

WHO STARTS?
It is generally a slight advantage to start first. By convention the player who won the last game 
chooses his preferred colour and starts first. If the two players have not played against each other
recently then use a coin. However, colours and 'who starts' must be decided before any tiles are 
picked up!

TOUCHING TILES
It is okay to test a move (or sequence of moves) by placing one or more tiles close to (but not 
touching) the tantrix. For example in figure 4 none of the tiles (A, B, C and D) are committed 
yet. It is a good idea to move the tiles close to the tantrix, and consider the effects before making 
a final decision. However, once a tile has touched another tile, it may not be moved or changed. 
You may not touch your opponent's tiles or cover your own tiles during the other player's turn.

TANTRIX RATING SYSTEM
The Tantrix rating system provides an international rating for serious players. The formula ranks 
all players out of 1000 points. Each time you play a game and submit the result you will move up
or down the ratings, depending on the ranking of your opponent, and the size of your win/loss. 
For the latest information on international ratings and a list of official competition rules, check 
out the Tantrix web page.



GLOSSARY!
BAG: All tiles are placed in a container referred to as the bag. Tiles must be picked up at 
random. However towards the end of the game players may count the number of tiles left in the 
bag, without looking inside!

BLOCK: One end of a line is blocked when no tiles fit the space at the end of the line. There are
two ways to permanently block your opponent's line:

Figure 15: Black is blocked
• Create a Forced Space at the end of your opponent’s line knowing there are few or no tiles 

left in the bag to fit the Forced Space. In figure 15 White is creating a Forced Space at A 
which cannot be filled. In fact, White has already calculated there are no tiles left that will 
fit. This end of Black's line is now blocked.

Figure 16: Permanent block
• Once the restrictions are lifted, you can permanently block your opponent's line by making 



three identical colours terminate into the Forced Space (figure 16). Black's line is blocked at 
B as there are no tiles which could ever fit this space!

BLUE TILE: Any tile that has a blue link is said to be a 'blue' tile. There are 42 blue tiles and 14
tiles that have no blue.

BRID: A Brid tile has two corner links and one straight link. Twelve of the 56 tiles are Brids (see
figure 17).

Figure 17: Brid tile

CONNECT: When two links of the same colour meet, they are connected. Wherever tiles touch 
each other, the links must connect!

CONTROLLED SIDE: The arrow in figure 18 shows a controlled side. The restriction rules 
forbid playing tiles along a controlled side. The Forced Space at A must be filled first, then B 
must be filled, then C etc before further tiles can be played along the side.

Figure 18: Controlled side

CHIN TILE: A Chin is a tile with one straight link and two bend links. Twelve of the 56 tiles are
Chins (figure 19).



Figure 19: Chin tile

DIRECT CONNECT: When a tile is connected directly to a player's line, the line length 
increases by one. In figure 23 the three white tiles are directly connected, and the three black 
tiles are indirectly connected.

DEADLOCK: Any phase of the game where both players have their progress temporarily halted
because both ends of their lines are blocked by unfilled Forced Spaces. Permanent deadlock is 
theoretically possible, but the chances are one in a million.

END GAME: The final phase of the game begins when no tiles remain in the bag. The 
restriction rules no longer apply, and it becomes easy for the players to block each other's lines.

FIT ANALYSIS: A tile is said to fit a space when the colours of all connecting links match up. 
Tiles that fit Forced Spaces are classified into three types (figure 20).

• ABC: Any combination of three different colours. There are five tiles that can fit any ABC 
space.

• ABA: A pair of colours separated by a different colour. There are six tiles that can fit any 
ABA space.

Figure 20: Three types of fits

• AAB or ABB: Any pair of colours plus another colour. There are six tiles that can fit any 
AAB space.

FORCED LOOP: Once a line has been forced into a loop it cannot be enlarged. Figure 21 
shows a small black forced loop. Forced looping is one of the best attacking strategies in Tantrix.



Figure 21: Black forced loop

FORCED SPACE: A space surrounded by three tiles is called a Forced Space (figure 22). 
Forced Spaces must always be filled immediately (if possible) by the player whose turn it is.

Figure 22: Forced Space

FREE MOVE: Each player has one free move per turn. However, players are required to fill 
any Forced Spaces immediately before and after their free move.

GREEN TILE: Any tile that has a green link is said to be a 'green' tile. There are 42 green tiles, 
and 14 tiles that have no green.

HAND: Each player has a 'hand' of six tiles. These tiles must be kept face up on the table and 
clearly visible to the other players.

INDIRECT CONNECTION: Figure 23 shows an indirectly connected black line. As the black 
line is almost guaranteed to connect at A and B, its indirect length is already five tiles long. By 
contrast the white line is directly connected but only three tiles long. Generally it is better to 
connect indirectly, but towards the end of the game, some indirect connects may become blocked
(if all the tiles which fit have been played elsewhere).



Figure 23: Indirect black connection

ISOLATED LINE: Minor lines that may or may not eventually connect to a player's longest 
line are called isolated lines. 

LINE: Any two or more links connected together form a line. The longest possible line consists 
of all 42 links of the same colour connected together. The average winning line between good 
players is about 23.

LINK: There are three different shapes of links (figure 24)

Figure 24: Three types of links

LOOKALIKE FIT: When a player is waiting for a specific tile to fit an important Forced Space
the opposing player should try to create a lookalike Forced Space. Figure 25 shows two identical 
Forced Spaces.

Figure 25: Lookalike fit

LOOP: A line which joins itself is called a loop and scores double points. In figure 26 the black 
loop has nine tiles so it scores eighteen points.



Figure 26: Black loop

RED TILE: Any tile that has a red link is said to be a 'red' tile. There are 42 red tiles and 14 tiles
that have no red.

RESTRICTIONS: There are three restricted moves that are not allowed as long as tiles remain 
in the bag. When no tiles remain, the restriction rules can be ignored.

Figure 27: Three restrictions

1. Do not create a Forced Space that is surrounded by three links of the same colour (27.1).
2. Do not play a fourth surrounding tile around an already Forced Space (27.2).
3. Do not play a tile along a controlled side (27.3).

ROND TILE: A Rond is a tile with three corner links (figure 28). Ronds make up 8 of the 56 



tiles.

Figure 28: Rond tile

SCORE: A player's score is calculated by counting the number of tiles in their longest line. 
However if the line is closed (ie a loop) then the score is doubled. The largest possible score in 
Tantrix is 84 points from a loop of 42 links, which is not very likely during a game - but makes a 
very interesting puzzle!

SINT TILE: A Sint is a tile with two bend links and one corner link (figure 29). Sints make up 
24 of the 56 tiles.

Figure 29: Sint tile

SPACE: All empty hexagonal spaces on the edge of the tantrix are referred to as 'spaces'. Any 
space surrounded by three sides is called a Forced Space.

STATISTICS: The 56 tiles can be categorised in various ways. There are:

• 42 tiles with a particular colour, eg 42 red tiles.
• 14 tiles which have a particular 3 colour combination, eg 14 red/blue/yellow tiles.
• 14 tiles missing a particular colour, eg 14 no-red tiles.
• 8 Rond, 12 Chin, 12 Brid and 24 Sint tiles.
• 18 tiles with a corner of a particular colour, eg 18 tiles with a red corner. 
• 18 tiles with a bend of a particular colour, eg 18 tiles with a red bend.
• 6 tiles with a straight of a particular colour, eg 6 tiles with a red straight.
• 8 crossings of any two colours, eg red crossing blue.
• 6 tiles which fit any AAB, BAA or ABA Forced Spaces.
• 5 tiles which fit any ABC Forced Space.

TANTRIX: The term 'the tantrix' refers to the tiles already played on the table. The tiles in each 
player's hand are not part of the tantrix. At the end of the game the tantrix will consist of all the 
tiles. Occasionally the players will agree to stop the game before all the tiles have been played, if
neither player can further improve their longest line.



TILE: There are 56 different tiles in each game, but only four basic shapes known as Sints, 
Brids, Chins and Ronds (see figure 30).

Figure 30: Four types of tiles

TRIPLE INTERSECTION: There is one tile shape not part of Tantrix. We call it a triple 
intersection. Early versions of Tantrix included this tile.    However, it was dropped from later 
versions because of its inconvenient geometrical properties (figure 31).

Figure 31: Triple intersection

TURN: Each player's turn consists of the following (never forgetting to pick up a new tile after 
every move).

• Start by filling any Forced Spaces possible.
• Then make a free move.
• Finish by again filling any Forced Spaces possible.

YELLOW TILE: Any tile that has a yellow link is said to be a yellow tile. There are 42 yellow 
tiles, and 14 tiles that have no yellow.



FREQUENTLY ASKED QUESTIONS
Q:    Is it permissible to play tiles without your own colour? 
A:    Yes, you can play any tiles anywhere (within the rules).

Q:    What happens when filling one Forced Space creates another Forced  Space?
A:    This is normal. Every newly created Forced Space should be filled, if possible.

Q:    If a player can fill more than one Forced Space, is the order important?
A:    Forced Spaces can always be filled in ANY order, no matter what the consequences are. 
However, the order can make a difference so choose carefully.

Q:    Do players still get a free turn if they are unable to fill any Forced Spaces?
A:    Yes, each player always has one free play per turn.

Q:    Towards the end of the game is it permissible to count the number of tiles left in the bag?
A:    Yes, but you may not look at the tiles.

Q:    Does the player who takes the final tile from the bag have to obey the restriction rules?
A:    No. He picks up the last tile, and from then on there are no restriction rules in place.

Q:    After the restrictions are lifted, do Forced Spaces still have to be filled?
A:    Yes.

Q:    After the restriction rules are lifted, is it permissible to surround a space by four or more 
tiles?
A:    Yes. However, a space surrounded by four tiles is still considered forced.

Q: After the restrictions are lifted is it permissible to create a space which has three links of the 
same colour as in figure 3.1?
A:    Yes. In fact, this is an excellent way to block an opponent's line.

Q:    Does the game finish when one player has used all his tiles?
A:    No. The game is finished once all players have finished.

Q:    If a player forms two loops does he or she score from both of them?
A:    No. Only a player's best score (from a loop or a line) counts.

Q:    During the end game, is a space surrounded by 3 non-contiguous tiles still a forced space?
A:    Yes!



TANTRIX PUZZLES
Introducing 25 solitaire puzzles ranging from easy to impossible (well almost)! Each puzzle is 
ranked from one to ten according to its difficulty. We recommend you start off on the easier 
levels and work upwards. Tantrix is a spatial learning experience and your skills will 
dramatically improve as you progress! Each time you try to solve a particular puzzle you will 
need to select the specific tiles for that puzzle. You can refer to the tile index each time, or you 
may prefer to write the tile number on the back of each tile. The 56 tiles can be split exactly into 
the Super 5 puzzles. Junior, Student and Master are single loop puzzles, Professor is a double 
loop puzzle, and the Genius is a double line puzzle.

Rules For All Puzzles
Loop Puzzles
Double Loop Puzzles
Double Line Puzzles



RULES FOR ALL PUZZLES
Choose a colour and make a loop or line using all the tiles with that colour. Remember a line is 
just a path and does not have to be straight. A loop means a closed loop (of any shape, not 
necessarily circular).

Figure 32: Puzzle rules

• Touching tiles must always match colour (connect).
• Holes are never allowed.
• All tiles with the selected colour must be used.
• Sometimes the tiles must be arranged in a specific pyramid or hexagon shape.



LOOP PUZZLES
Loop puzzles are the classic Tantrix puzzles, and we particularly recommend the Original and 
Master. Choose a colour and make a loop using all the tiles with that colour. In each puzzle 
normally only one colour has a solution but which one?

• STARTER (Level 2), 6 tiles.
• BASIC (Level 3), 8 tiles.
• ORIGINAL (Level 3), 10 tiles. All 3 colours can be solved!
• JUNIOR (Level 3), 10 tiles.
• STUDENT (Level 4), 10 tiles.
• MASTER (Level 6) - 12 tiles.



DOUBLE LOOP PUZZLES
Double loop puzzles are particularly satisfying to solve. Choose two colours and make a loop 
simultaneously of each. For example if you choose blue and green, then all the tiles with blue 
must form a blue loop at the same time that all the tiles with green are forming a green loop. 
Tiles with both blue and green must be in both loops simultaneously.

• PROFESSOR (Level 5) - 12 tiles.
Choose two colours and make a loop of each simultaneously. But which colours?



DOUBLE LINE PUZZLES
Double line puzzles are usually harder than double loop puzzles. Choose two colours and make a
line of each colour simultaneously. All the tiles of each colour must be in both lines (as in the 
Double Loop Puzzles).

• GENIUS (Level 8) - 12 tiles.
The famous genius puzzle has, in fact, two different solutions:
a) Make a double line in any shape using all red and yellow tiles.
b) Make a double line in any shape using all red and blue tiles.



File Menu Commands
The File menu offers the following commands:

New Create a new game.
Open Open an existing game.
Close Close an open game.
Save Save an open game using the same file name.
Save As Save an open game to a specified file name.
Save Copy As Save an open embedded game to a specified file name.
Update Update an open embedded game.
Import Import a game from a text file.
Export Export an opened game to a text file.
Print Print a game.
Print Preview Display the game on the screen as it would appear printed.
Print Setup Select a printer and printer connection.
Exit Exit Tantrix.



New Command (File Menu)
Use this command to create a new game in Tantrix.    Select the type of new game you want to 
create in the File New dialog box.

You can open an existing game with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Competition Rules
Under competition rules you cannot "undo" a move once it is made and you are not allowed to 
view the contents of the bag.    In addition, a competition rules game between two players is 
entered into the rankings table once the game is finished.



Open Command (File Menu)
Use this command to open an existing game.    Select the game you want to open in the File Open
dialog box.

You can create new games with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



Close Command (File Menu)
Use this command to close the game.    Tantrix suggests you save changes to your game before 
you close it.    If you close a game without saving, you lose all changes made since the last time 
you saved it.    Before closing an untitled game, Tantrix displays the Save As dialog box and 
suggests you name and save the game.



Save Command (File Menu)
Use this command to save the game to its current name and directory.    When you save a game 
for the first time, Tantrix displays the Save As dialog box so you can name your game.    If you 
want to change the name and directory of an existing game before you save it, choose the Save 
As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As Command (File Menu)
Use this command to save and name the game.    Tantrix displays the Save As dialog box so you 
can name your game.    

To save a game with its existing name and directory, use the Save command.



1, 2, 3, 4 Command (File Menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four games 
you closed.    Choose the number that corresponds with the game you want to open.



Exit Command (File Menu)
Use this command to end your Tantrix session.    You can also use the Close command on the 
application Control menu.    Tantrix prompts you to save games with unsaved changes.

Shortcuts
Keys: ALT+F4



Print Command (File Menu)
Use this command to print a game.    This command presents a Print dialog box, where you may 
specify the number of copies, the destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Preview Command (File Menu)
Use this command to display the game as it would appear when printed.    When you choose this 
command, the main window will be replaced with a print preview window in which one page 
will be displayed in its printed format.    The print preview toolbar offers you options to view 
either one or two pages at a time; move back and forth through the game; zoom in and out of 
pages; and initiate a print job.



Print Preview Toolbar
The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup Command (File Menu)
Use this command to select a printer and a printer connection.    This command presents a Print 
Setup dialog box, where you specify the printer and its connection.



Update Command (File Menu)
Use this command to save the game to its OLE container.



Save Copy As... Command (File Menu)
Use this command to save and name the game.    Tantrix displays the Save As dialog box so you 
can name your game.

To save a game in its OLE container, use the Update command.



Import Command (File Menu)
Use this command to import an existing game that has been stored as a text image.    This is 
sometimes used to open a game that has been received within the text note of an email message.



Export Command (File Menu)
Use this command to save and name the game as a text file.    Tantrix displays the Save As dialog
box so you can name your game.

To save a game with its existing name and directory, use the Save command.



File Open Dialog Box
The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    You can only open files saved by tantrix 
(these normally have a ".txg" file extension).

List Files of Type
Select the type of file you want to open (has to be set to ".txg").



File Save As Dialog Box
The following options allow you to specify the name and location of the file you are about to 
save:

File Name
Type a new filename to save the game with a different name.    Tantrix adds the extension you
specify in the Save File As Type box.



Print Dialog Box
The following options allow you to specify how the game should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup or Properties option to 
change the printer and printer connection.

Copies
Specify the number of copies you want to print for the above page range.



Print Setup Dialog Box
The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer
option and select one of the currently installed printers shown in the box.    You install 
printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the game is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the 
type of printer you have selected.



File New Game Dialog Box
Create a new game between yourself and the computer.    You will need to enter your name, email
address, country and colour.    You can choose which computer player to compete against, 
together with the level and colour of the computer player.    You can also control whether the 
computer player should move first and whether the game should be played under Competition 
Rules.

When accessed via the Edit/Player Details menu option you can alter each player's name, email 
and country information.    The colours and types of players cannot be altered once a game has 
been started.



File New Game Dialog Box
Create a new game between yourself and up to three other players who will all play at this 
computer.    For each player you will need to have the player’s name, email address, country and 
colour.



File New Game Dialog Box
Create a new game between yourself and up to three other players who will all play at this 
computer.    For each player you will need to have the player’s name, email address, country and 
colour.



File New Dialog Box
Specify the type of game you wish to create:

Play a puzzle Creates a new puzzle game.    You can choose between six loop puzzles, a
double loop puzzle and a double line puzzle.

Play the 
computer

Create a new game between yourself and the computer.    You will need to
enter your name, email address, country and colour.    You can choose 
which computer player to compete against, together with the level and 
colour of the computer player.    You can also control whether the 
computer player should move first and whether the game should be 
played under Competition Rules.

Play other 
Players on this 
Computer

Create a new game between yourself and up to three other players who 
will all play at this computer.    For each player you will need to have the 
player’s name, email address, country and colour.

Play other 
Players by 
Email

Create a new game between yourself and up to three other players who 
will play by email.    For each player you will need to have the player’s 
name, email address, country and colour.    You will need to indicate 
which players are to be contacted by email.

Play other 
Players Online 
using 
DirectPlay

Create a new game between yourself and up to three other players who 
will play online using DirectPlay.    This feature is only available under 32
bit versions of Microsoft Windows (Windows 95/97/NT).    The other 
players must be accessible by DirectPlay (via a network, direct 
connection or modem).



Playing Tantrix on the Computer
The following sections explain how to play Tantrix on the computer:

Starting a new game or puzzle:
Use the File/New option to select what sort of game or puzzle you want to play.

Selecting a tile to play:
When it is your turn the first step is to select the tile you want to play.    Only one of 
your own tiles can be selected.    Once selected the tile will appear in a different 
colour.    You can select a tile by clicking once with the mouse or by pressing the 
TAB key a number of times until the tile you want is selected.

Moving the selected tile:
Once you have selected a tile to play next step is to move it to the location you want 
it to be played.    You can move the selected tile by clicking in the middle of a tile 
then dragging with the mouse.    You can also move a tile with the arrow keys (hold 
the shift key down to move very small distances).    You can also move the selected 
tile to a playable space by clicking on the playable space.

Rotating a tile:
Often you will want to rotate a tile before playing it.    Once you have selected a tile 
you can rotate it by using the rotation buttons in the toolbar, the rotation menu option
under the Edit menu or by right-clicking on the tile and using the rotation menu 
options presented.    You can also rotate tiles using the page-up and page-down keys 
or by clicking on the right or left side of the tile.

Playing a tile:
Once you have moved and rotated a tile to the position you want to play it you can 
play the tile by double clicking on it, or right-clicking on the tile and selecting the 
Play Here menu option.    You can also press the Enter key to play the selected tile in 
its current position.    When you play a tile it will automatically be rotated to fit the 
playable space if required.

Reversing a move:
Under competition rules you are not allowed to undo or reverse your last move.    
Under normal rules you can reverse the last move by clicking on the Undo button or 
using the Undo menu option under the Edit menu.

Replaying a game:
You can replay a game at any time by clicking the Replay button or by using the 
Replay menu option under the Edit menu.    This will replay the moves in the game 
one move at a time.    A button will appear prompting you to click to make the next 
move.



Playing puzzles:
The easiest way to play a puzzle is to move and rotate all the tiles until you believe 
you have solved the puzzle.    Then play the tile that is positioned above the single 
playable space in the middle of the screen.    The other tiles will remain in position 
and those touching the first tile played can now be played.    Once you have played 
all the tiles the computer will check to see whether the puzzle has been solved 
correctly.



Chat Command (Edit Menu)
Use this command to chat to other online players when playing an online game under Windows 
95 or Windows NT.    This displays the Chat dialog box.



Edit Chat Dialog Box
Lets you send and receive text messages from other online players.



Join Online Game Dialog Box
This dialog lets you enter your name, colour, email address and country details.    You can then 
join an existing online game.    Your name must be entered and the text fields cannot contain the 
plus '+' character.    Your colour must not clash with any other existing player.

Click the Refresh button to update the list of available games.



Wait for Online Players Dialog Box
This dialog appears after you have started or joined an online game.    As soon as other players 
arrive in the game their name will appear in the dialog box.    As soon as the correct number of 
players has arrived the game will begin.



Online Game Dialog Box
This dialog lets you chose a method of connecting to other online players and then lets you chose
to host a new game or join an existing game.



Host Online Game Dialog Box
This dialog is displayed when you are about to start a new online game.    It lets you enter a name
for the new game that will be visible to other players as they join your new game.    You will also 
need to enter the number of players.    

After entering your name, colour, email address, country details and competition rules flag you 
can click the OK button to wait for other players to join your game.




